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“OK, maybe I’m dense, but explain to me again—why are we going down this manhole into the city sewer 
at night?” Andy glanced around nervously as the streetlamp cast long shadows across the quiet city street. 
He was just a summer intern with the Minnesota Pollution Control Agency (mpca) and not at all used to 
sleuthing.

“See that dry cleaning shop over there?” explained Tracy. “We’re trying to catch them illegally dumping 
cleaning fluids into the environment via the sewers. My colleagues and I at the mpca have been onto this guy 
for a while, and something just doesn’t smell right.”

“What doesn’t smell right is this sewer,” replied Andy. “So what if someone’s dumping liquids into the sewer 
system? Isn’t that what sewers are for? They lead to the wastewater treatment plant in St. Paul, which is 
designed to clean dirty water before discharging it into the Mississippi River.”

“What they are dumping is not water-based, Andy. Dry cleaning is a process that uses a fluid other than water 
as a solvent in the cleaning process. In the past, these solvents were camphene, benzene, kerosene, gasoline, 
etc., but because these are highly flammable liquids, a safer synthetic solvent was developed. However, just 
because it’s safer for clothes and people working with it doesn’t mean it’s environmentally friendly. It won’t 
be properly broken down or degraded by the wastewater treatment plant before entering the river.”

“So, what is this great solvent, and why is the mpca involved?” Andy asked.

“The chemical is perchloroethylene, also known as tetrachloroethylene or ‘perc’ for short. It was introduced 
in the 1930s and is still the industry standard today. About 85% of dry cleaners in the U.S. use a liquid 
solution of perchloroethylene, which removes stains and dirt from most fabrics and doesn’t cause shrinkage 
of clothes or bleeding of dyes. Perc can be captured at the end of a wash cycle, cleaned using an evaporator 
and separator, and reused. It is generally a safe, cost-effective, and efficient process for cleaning clothes.”

“However,” continued Tracy, “there are two problems with perc. First, it is very volatile and can cause indoor 
and outdoor air quality problems if allowed to evaporate in bulk. The Department of Health and Human 
Services notes that perc is a potential human carcinogen; exposure to high levels of perc can result in 
depression of the central nervous system and damage to the liver and kidneys. Even brief exposure can cause 
confusion, dizziness, headache, drowsiness, and eye, nose, and throat irritation.

“A second problem with perc comes with its recovery and reuse. Evaporators and separators use water to clean 
the dirt from used perc, which floats to the top of the separator water to be recovered and used again. The 
mpca considers this water to be a hazardous waste, which requires a permit and special disposal treatment. 
This permit and disposal process is costly and time consuming, and is seen as unreasonable by most dry 
cleaners. In response, the mpca allows for the discharge of the separator water to municipal sewers if certain 
conditions are met, namely, only the water and not the perc is discharged; the sewer is connected to a 
publicly owned treatment works and not a dry well, cesspool, or septic tank; and detailed records are kept 
and reported to the mpca regarding the amount of waste generated and discharged.
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“We suspect that this dry cleaner is falsifying the records and discharging not only greater amounts of 
separator water to the sewer system, but significant quantities of perc as well.”

“What makes you think this dry cleaner isn’t following the rules?” asked Andy.

“All dry cleaners must record monthly purchases of dry cleaning fluids such as perc, backed up by sales 
receipts and reported annually to the mpca. Based on his receipts and reports, he is purchasing large 
quantities of perc monthly, but transporting far less waste perc to disposal sites than we expect to be 
recovered by the distillation process. Either he has a faulty recovery system, allowing too much perc to 
volatilize into the air, or he is dumping some down the floor drain in his building, which is supposed to be 
blocked. He won’t let us in to inspect his evaporation recovery equipment or his floor drain without a court 
order, and we don’t have enough evidence at this point to get an inspection order issued.”

“Why would he do this?” asked Andy. “Isn’t he wasting valuable perc by flushing it down the drain?”

“After a few passes through the wash cycle, some perc cannot be reasonably cleaned by evaporators and 
separators, and must be replaced. The old perc is usually stored in drums on-site until transported to 
a hazardous waste site for disposal. mpca rules allow very small quantity generators (vsqgs), those that 
produce less than 220 pounds or about 22 gallons liquid of hazardous waste per month, to store up to 2,200 
pounds on-site indefinitely and transport their waste themselves to a household hazardous waste (hhw) 
collection site for disposal for a small fee. If a company produces more than 220 pounds but less than 2,200 
pounds per month, they are reclassified as a small quantity generator (sqg), which requires them to dispose 
of their wastes 180 days after wastes are first put in the container, use a licensed hazardous waste hauler for 
the transport, and use a commercial hazardous waste disposal facility. Being classed as a sqg adds additional 
layers of paperwork, transport costs, and disposal costs.”

“Oh, I get it,” said Andy. “This guy is probably going over his storage limit and doesn’t want to be reclassified 
as a sqg. It’s cheaper for him to stay a vsqg, so he’s dumping some of his waste perc down the drain and 
hauling the rest to a hhw collection site to maintain the guise that he is actually complying with proper 
disposal protocols. Well, how do we gather concrete evidence to inspect his operation and stop him if he is 
indeed illegally dumping waste perc?”

“The Minnesota Technical Assistance Program (mntap), sponsored by the University of Minnesota, has 
a halogen meter that they loan out for free. We’re putting it in this sewer under the city street in front of 
his business and will come back and retrieve it in a few days to see if it got a detect for perc. Because dry 
cleaners are the only ones that use this solvent locally and he’s the only operation around here, it would be 
pretty damning evidence that he’s conducting some illegal dumping. Once we have that, we should be able 
to get a court order for an inspection of his premises and records.”

Tracy and Andy climbed back out of the sewer and replaced the manhole cover.

“How did this issue even come to your attention? You have a thing against dry cleaners?” asked Andy as they 
walked back to their truck.

“No,” replied Tracy, “all users of potentially hazardous or toxic substances are inventoried and tracked 
by federal and state agencies. We generally like to know where toxic substances are stored or used in our 
environment, especially if they have the potential to adversely affect air and water quality. Dry cleaners are 
one of the industry groups that are required to be listed in the U.S. Environmental Protection Agency’s 
Toxic Release Inventory (tri) database. So, I knew this dry cleaning shop was here, and a routine review of 
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their records from the last few years showed a chronic discrepancy in the amount of new perc they’ve been 
bringing in and waste perc they’ve been shipping out.”

“Toxic Release Inventory database?” said Andy. “I’ve never heard of it. Who is on this list and what is it used 
for?”

“Well, if you’re interested, I have a simple computer exercise using gis to explore this inventory that you can 
do in the office tomorrow morning—after you’ve showered, of course.”

https://sciencecases.lib.buffalo.edu/
https://sciencecases.lib.buffalo.edu/collection/uses/
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GIS Exercise
gis, or Geographic Information Systems, refers to the collection, organization, maintenance, analysis, and 
output of spatially referenced information. Most, if not all, environmental problems have a spatial context to 
them, and gis allows us to inventory and manage our environment more efficiently. If all we were interested 
in was making a map, we could use colored pencils and paper. gis, however, incorporates analysis tools that 
allow us to link spatial and non-spatial information, perform spatial overlays of different information layers 
(e.g., roads, soils, water bodies, businesses, etc.), query databases, find relationships among different thematic 
variables such as soils, polluters, and groundwater, and analyze spatial patterns that otherwise would not be 
obvious or possible.

Before Starting
Read over this handout carefully before starting this gis exercise. This gis exercise can be complicated and 
requires a good understanding of how contaminants and toxins behave in the environment.

I encourage you to work in groups of two rather than by yourself. Computer frustrations are usually minimized 
when people work together. Please don’t hesitate to see the instructor if you have questions or difficulties. 
Everyone needs to turn in their own individual report.

Overview
We take many products we buy and use for granted, but don’t realize that there are potential dangers to us 
and our environment when these products are created or used. Many products require chemicals for their 
production or use, and some of these compounds can be quite nasty if released accidentally or purposefully 
into the environment.

The Problem
Some compounds are highly toxic and poisonous to biota (living things). Many compounds, even diluted to 
very small concentrations in water, soil, or air, can have acute (immediate) or chronic (long-term) effects on 
living organisms. Where these toxins end up (in the air, soil, or water) partially dictates the path of delivery 
to organisms, what organisms are affected and how, potentially, the toxins are rendered harmless (dispersed 
or degraded). Based on their behaviors, compounds can preferably enter the atmosphere, dissolve in water, 
or stay in the soil.

In the atmosphere
Certain toxins are volatile; in other words, they “evaporate” readily and enter the air. Compounds such as 
vocs (volatile organic compounds) generally will evaporate quickly after a spill before they have time to enter 
the land surface to contaminate soil or groundwater. These compounds can pose health risks to air breathers 
in a local area before they are dispersed or diluted by wind. Other compounds are not immediately toxic 
to biota, but can enter the global atmosphere and cause problems far from the source (e.g., odcs—ozone 
depleting compounds, such as Freon, which degrade the ozone layer).

In water
Some toxins are soluble in water and can contaminate water sources directly (runoff into a lake or stream) or 
enter the local groundwater system via infiltration and percolation. These compounds can move rapidly in 
the case of surface runoff, or more slowly in the case of groundwater contamination. Some compounds are 
not water-soluble (they are lipid-soluble) and can persist in a water body or be moved as droplets (much like 
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oil and water in a salad dressing). Water can dilute or dissipate toxic compounds, sometimes rendering them 
less harmful. Organisms such as microbes or certain plants can take in and detoxify some compounds at or 
near the surface, but contaminated groundwater may require an engineering solution to detoxify a spill area 
(e.g., pump and treat).

In the soil
Many compounds (water-soluble, lipid-soluble, or neither) enter soils and can persist for decades before 
being degraded by microbes, taken up by plants, or removed using an engineering solution (excavation and 
incineration). Because activities that make or use toxic compounds are located primarily on land (factories, 
farmlands, etc.), soils usually are the first recipients of toxic wastes and spills, whether deliberately (in 
the case of landfills) or accidentally. Some are heavy metals that don’t dissolve in water, are adsorbed to 
soil particles and don’t migrate, and can persist in a contaminated soil for years. Others are mobile and 
move with percolating soil water after a rainstorm, flushing the surface soil clean (although the underlying 
groundwater is now contaminated).

TRI Data
The Toxics Release Inventory (tri) is a publicly-available U.S. Environmental Protection Agency (epa) 
database that contains information on toxic chemical releases and other waste management activities 
reported annually by certain covered industry groups as well as federal facilities. This inventory was 
established under the Emergency Planning and Community Right-to-Know Act of 1986 (epcra) and 
expanded by the Pollution Prevention Act of 1990.

The data used in this exercise were obtained from the epa’s Toxics Release Inventory data set available on cd 
(this data was compiled for 1987–90) from their Office of Pollution Prevention and Toxics.
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Instructions
These instructions provide a basic introduction to ESRI ArcView 3.3 and are intended to get you started 
with the software and cd data resources. Important: As you work your way through this exercise, DO NOT 
SAVE YOUR WORK. Saving any part of this project can alter default settings, creating stress and headaches 
that no fellow student deserves.

Start ArcView
When these instructions say “click,” use the left mouse button.

1. Open the program by clicking on the Start menuProgramsESRIArcView GIS 3.3, and the 
program ArcView GIS 3.3.

2. After the program loads, you will be asked whether you want to create a new project or open an 
existing project.
 • Select open an existing project and click on OK.

3. A window asking for the project’s file name and drive will open in the center of the screen.
 • In the bottom right side of the window, set the drive to the drive letter specified by your instructor.
 • Next, navigate to the proper folder on the drive, as specified by your instructor.
 • Then click on the folder labeled Toxic_releases

 4. A file titled “toxic_releases.apr” will appear in the left half of this window.
 • Click on toxic_releases.apr and click on OK

The project opens with a map showing where the study area involved in this exercise is located in Minnesota. 
After familiarizing yourself with this map, close it, but not the ArcView program.

You are now looking at a map showing the 7-county Twin Cities (Minneapolis and St. Paul, Minnesota) 
metropolitan area, including county boundaries and water bodies.

You will note that some of the themes are not turned on.

Turn on the tri data theme by checking the box next to the words “Toxic Release Inventory data” to 
see where potentially toxic chemicals are being used around the Twin Cities metro area. Notice the overall 
pattern of use—some counties have more businesses using them, some have less.

Next, turn on the theme titled “Railroads.” Notice the general pattern of location of these businesses in 
relation to rail lines. Many of these compounds enter or exit our community via rail, since they are shipped 
in bulk. Accidental releases of hazardous materials can be the result of railroad car derailments and accidents, 
spilling thousands of gallons of material onto the land along these corridors. We won’t do anything with 
this theme—I just wanted you to get a feel for why these toxic release points are located where they are, and 
what areas of land are most at risk from accidental release due to transport. You can turn off this theme by 
removing the check mark in the box next to the title.

Make sure that the Toxic Release Inventory data theme is active. Do this by clicking (once) on it in the 
table of contents—it will then appear to be a raised tile. Familiarize yourself with the tools as follows.

• Choose the “i” with the circle around it   (second row of tools—the first one). The “i” is for 
identify.

• Point at any dot on the map indicating a toxic release location. You can zoom into any point by 
choosing the magnifying glass with the plus in it.   (It is in the second row of tools—five from the 
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left.) Center the magnifying glass on a point and click two or three times.

• Return to the full view by zooming back—choose the magnifying glass with the minus sign in it. 
Repeat as needed.

• If the map is off-center, use the pan tool  (second row of tools—seven from the left) to center 
it. Use the down arrow to see what data (called attributes) there are for each point. The variable 
called “Fac_name” shows who owns the company that produces or uses the compound (followed by 
other variables that tell the address of the factory), “Substance” tells the name of the compound, and 

“ChemGroup” refers to a grouping of the material based on its general properties or uses (acid, poison, 
heavy metal, etc.). We’ll use this information soon. Point at a few other locations just to see what 
attribute data are associated with each tri point.

• Close each data table by clicking on the “X” in the upper right side of its window.
Next, let’s make this map more informative by using color to show the differences in compounds based 
on their chemical grouping. To do this, double click on Toxic Release Inventory data. This will open 
the Legend Editor window. Change the Legend Type to “Unique Value” (this will assign unique colors to 
each variable) and change the Values Field to “ChemGroup” (this is the variable containing information on 
chemical type). Finally, click on Apply.

Notice that each chemical group is now color-coded and labeled for easy identification. The group names 
referred to are:

1. Ammonia—these compounds contain nitrogen, a plant essential nutrient. Large quantities in the 
soil or groundwater can have a variety of unwelcome effects: acidity, excess nutrients, discoloration 
of water, odors, etc. These compounds can also volatilize into the atmosphere, creating toxic 
plumes that cause a burning sensation in the eyes, nose, and throat at low concentrations, and 
acid burns in the lungs and on the skin at high concentrations (forms nitric acid on contact with 
moisture from mucus membranes).

2. odc—ozone depleting compounds, basically Freon 113. These enter the airshed readily, and are 
more of a threat to global stratospheric ozone than to biota in the immediate vicinity.

3. voc—volatile organic compounds, generally carbon-based compounds that readily volatilize, with 
names ending in “-ane,” “-ene,” or “-one.” These evaporate quickly into the air and are spread or 
dispersed by winds. They pose the most risk to biota downwind in the airshed.

4. Acid—what is says. These can be sulfuric (used in car batteries), hydrochloric, nitric, etc. Most 
are used in industrial processes to clean or etch metals and glass. They can contaminate soil, 
decreasing its fertility and increasing its acidity, neither of which is good news for plants or soil-
based life (bacteria, earthworms, moles, etc.).

5. Alcohol—water soluble; these may not be hazardous, depending on their type or concentration in 
water. Alcohols are also volatile and may pose air quality issues in the immediate vicinity following 
a spill, until the plume dissipates in the air. Windy days help with the dispersal/detoxification of 
these compounds.

6. Heavy metals—these compounds (lead, chromium, silver, nickel, zinc, copper, etc.) can be toxic 
to biota at various concentrations. Some of them are essential nutrients to plants and animals at 
low levels (copper, zinc) but toxic at high levels; others are not tolerated even at trace levels (lead, 
chromium, cobalt). They generally adsorb to soil particles and are not transported by or dissolved 
in water.
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7. Other—compounds that do not fit easily into one of the other groups or may/may not be 
hazardous.

8. Poison—what it says. These compounds are directly toxic to biota, although the LD50 dosage may 
differ by compound or delivery. Many are not volatile, and can stay in the soil until they dissolve 
in percolating rainwater to enter and contaminate groundwater supplies.

To examine the data associated with this map theme, click on the button at the top of the screen that looks 

like a data table:  After familiarizing yourself with the data contained in the table, move it down out of 
the way so you can see both it and the map of the 7-county tri data.

Data Analyses
Now that you have a basic understanding of how the software works and how the map shapes (county 
boundary areas, railroad lines, etc.) are linked to databases of information (attribute tables), we can perform 
some spatial analyses on the different toxic compounds to see how they will behave if released into the 
environment.

First, you need to determine which compounds are hazardous to air, soil, water, or all three. Let’s ignore 
the “Other” category for now. Using a piece of paper, group the seven remaining compounds into hazard 
categories (see the explanations below):

• Air
• Water
• Soil
• Highly dangerous

If something is primarily volatile, it is of greatest threat to the air (and air breathers). If something is not 
very volatile but is water soluble, it may pose a greater risk to water resources (surface and groundwater) 
and aquatic life. Substances that adhere to soil particles and resist movement/transportation via moving 
water (either on the ground surface or percolating rainwater) pose more of a long-term threat to terrestrial 
plant and animal life in that area. A highly dangerous compound (poison) is acutely toxic to biota. Because 
different compounds have different vectors or targets and have different levels of danger, we will explore each 
of these pathways separately. gis facilitates this analysis because the software includes a tool called Query 
Builder, which can be used to query the database and select only those compounds of interest.

Task 1. Make a map showing only air hazards
Once grouped, we will make a map showing the locations of these point sources of air pollution. Once you 
determine which compounds should be included in this group, we will create a map of just these threats to 
air quality.

First, make sure the Toxic Release Inventory data theme is active. Our next step is to select all of the points 
representing air hazards.

Click on the Query Builder button. It looks like a hammer with a question mark:  We will build a 
query to select only those compounds that are air hazards.

Scroll down to the bottom of the left-hand list and double-click on ChemGroup, then click once on the 
equal sign (=), then double-click on the first chemical group in the right-hand list that you have identified 
as a hazard to the air. Click the “New Set” button to select these records. You should see these records 
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highlighted in yellow in the attribute table. Now double-click on the next chemical group in the right-hand 
list that is an air hazard. Click the “Add to Set” button to add these records to your list. Continue until all 
the air hazards have been selected. Close the Query Builder when you have added all the data points for this 
set. You’ll notice that some of the dots representing tri points have turned yellow—these are the records that 
you have selected using the Query Builder (air hazards).

The next step is to create a new map theme that shows only these air hazards.

Use the Theme menu Convert to Shapefile option.

A new window will open. Under File Name, type air_hazards and then click on OK. Another window will 
open. Click No. When asked if you want to add the shapefile as a view, click Yes.

A new theme titled air_hazards will be added to the table of contents. Turn off the Toxic Release Inventory 
data theme. Turn on the air_hazards theme and look at where these hazards are located in the 7-county 
area. You can also discriminate the type of hazard by changing from “Single Symbol” to “Unique Value” with 

“ChemGroup” in the Value Field (just like you did for the Toxic Release Inventory data theme).

Print this map in the following manner:

Turn on only the County boundaries and Air_hazards themes. To design a proper map, use the View menu 
Layout option. Click OK to select the Landscape view. This will produce a printable map (you can change 
the title from “View 1” to “Air hazards” by double-clicking on it). Use the File menu Print option to send it 
to the printer.

Task 2. Make a map showing only groundwater hazards
This is slightly more complicated, because we have to consider where spilled contaminants can actually 
penetrate deep enough to contaminate the groundwater. Different soils have different permeabilities and 
are either “leaky” or not. If a soil is permeable, it is “leaky” and contaminants spilled on the surface can 
percolate or leach downward, below root zones or surface waters, and into the groundwater. If a soil is 
impermeable, it is “tight” and contaminants tend to stay put at the surface in the soils where they are spilled, 
causing potential problems at the site for many years. We will concentrate on Hennepin County only, 
because this is the only Twin Cities metro county where we have detailed soil data (SSURGO county data 
base developed by the NRCS—Natural Resource Conservation Service).

This is a three-step process: first we’ll create a theme showing locations of chemicals that are water hazards, 
then create a theme showing where “leaky” soils exist, then overlap the two themes to show where in the 
county downward movement of these dissolved contaminants can occur.

Turn off all themes except Water bodies and County boundaries. Make sure the Toxic Release Inventory 
data theme is active. Use the Query Builder to select only those Chemical Groups that are water hazards 
(soluble in water), and save this theme as a shapefile, naming it “groundwater_hazards.” Turn this theme 
on to see where these are located.

Make the Hennepin soils theme the active theme, but don’t turn it on (it takes too long to draw into the 
view). We are only interested in areas where soils are well- to excessively-drained; these soils are “leaky” and 
will allow contaminants to pass downward into the groundwater.

Click the Query Builder button. Before you do anything else, use the mouse to check the Update Values 
box. Now, build a query using [drainage_c] in the left scroll box, the equals sign, and then “Excessively 
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drained” in the right scroll box. Click New Set. Add to Set the following fields out of the right scroll box: 
“Moderately well drained,” “Somewhat excessively drained,” and “Well drained.”

You have now selected all the records that represent soils with a “leaky” drainage class. Create a shapefile 
from this by using the Theme menu Convert to Shapefile option, and name the theme “Drainage.” 
Change from “Single Symbol” to “Unique Value” with “Drainage_c” in the Value Field. Draw it into view to 
see where highly permeable soils exist. You can use the Zoom-in tool  to just have Hennepin County in 
the view.

ArcView provides the ability to select the features of one or more themes using the features of another theme. 
Selecting features in this way is one of the spatial analysis methods you can use to resolve problems that 
involve issues of proximity, adjacency, and containment. To get the final map, we need to spatially overlay 
the two themes, groundwater_hazards and drainage. By overlapping these two themes, we’ll be able to 
identify where on the landscape surface spills would have the ability to leak below the surface. We will use 
the Geoprocessing Wizard for this.

Use the View menu, Geoprocessing Wizard option. A new window will open. Choose the last option, 
“Assign data by location (Spatial Join).” A spatial join is based on the spatial relationship between the 
features in two themes. For each feature represented in one table, ArcView looks to see if it has a spatial 
relationship (near, within, touching, etc.) with any feature represented in the other table and, if it does, that 
feature’s record is joined from one table into the other.

Click Next. You want to assign data TO groundwater_hazards and assign data FROM drainage. Click 
Finish. This operation will link the drainage information to the chemical information, allowing for a 
selection of just those sites (businesses) that use chemicals which can actually make it to the groundwater 
if spilled. Double click on the groundwater_hazards theme to open the Legend Editor, and change 
from “Single Symbol” to “Unique Value” with “Drainage_c” in the Value Field. Draw it into view to see where 
chemicals are used over highly permeable soils in Hennepin County.

Print this map in the following manner:

Turn on only the County boundaries, Water bodies, and Groundwater_hazards themes. Use the 
View menu Layout option to design the map. Click OK to select the Landscape view. This will produce 
a printable map with just Hennepin County in the view (you can change the title from “View” to 

“Groundwater hazards: Hennepin county” by double-clicking on it). Use the File menu Print option to send it 
to the printer.

Task 3. Make a map showing only soil hazards
This is a three-step process as well: first we’ll create a theme showing locations of chemicals that are soil 
hazards, then create a theme showing where “tight” soils exist, and finally overlap the two themes to show 
where in the county downward movement of chemicals is restricted due to low permeability. This process 
will produce a map of areas that are threatened with long-term soil contamination.

Turn off all themes except Water bodies and County boundaries. Make sure the Toxic Release Inventory 
data theme is active. Use the Query Builder to select only those Chemical Groups that are soil hazards, and 
save this theme as a shapefile, naming it “soil_hazards.” Turn this theme on to see where these are located.

To identify where impermeable soils exist, go back to your Hennepin soils theme and open its attribute table 
again. You’ll notice that the records you selected to make the groundwater hazards map are still highlighted 
in yellow. Because you have already selected the soils that are very permeable, to select the soils of low-
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permeability you simply need to switch the highlighted records to those that are not currently selected. To 
switch the selected records to those currently not highlighted, click the button with two curved arrows:  
(Switch Selection button, top row, seventh from left.) Now, only those soils that are not well-drained are 
selected.

You have now selected all the records that represent soils that are not “leaky,” but “tight.” Create a shapefile 
from this by using the Theme menu Convert to Shapefile option, and name the theme “low permeability.” 
Change from “Single Symbol” to “Unique Value” with “Drainage_c” in the Value Field. Draw it into view to 
see where low-permeability soils exist. You can use the Zoom-in tool  to just have Hennepin County in 
the view.

Now to get the final map, we need to spatially overlay the two themes, soil_hazards and low_permeability. 
We will use the Geoprocessing Wizard for this.

Use the View menu Geoprocessing Wizard option. A new window will open. Choose the last option 
“Assign data by location (Spatial Join).” Click Next. You want to assign data TO soil_hazards and 
assign data FROM low_permeability. Click Finish. This operation will link the drainage information to 
the chemical information, allowing for a selection of just those sites (businesses) that use chemicals which 
probably will not move but sit in or on the soil for years if spilled. Double click on the soil_hazards theme 
to open the Legend Editor, and change from “Single Symbol” to “Unique Value” with “Drainage_c” in the 
Value Field. Draw it into view to see where chemicals are used over low-permeability soils in Hennepin 
County.

Print this map in the following manner:

Turn on only the County boundaries, Water bodies, Soil_hazards, and Low_permeability themes. Use the 
View menu Layout option. Click OK to select the Landscape view. This will produce a printable map (you 
can change the title from “View 1” to “Soil hazards: Hennepin county” by double-clicking on it). Use the File 
menu Print option to send it to the printer.

Task 4. Make a map showing only highly dangerous compounds (poisons)
This one involves a different analysis using ArcView than the other maps. For this map, we will use only the 
“Poison” chemical group. Because these compounds can dissolve in water and contaminate groundwater, we 
have to worry about underground transport of the poison from where life isn’t (in underground aquifers) 
to where it is (surface water bodies such as lakes and rivers that contain fish and macroinvertebrates). To do 
this, we have to understand how water moves underground through the porous media in which it dwells, 
and calculate the time of arrival from a spill site to a water body. Generally, we are concerned with the 
10-year time of travel, or the distance a contaminated plume of water will flow in 10 years time based on 
the hydraulic properties of the aquifer. We will use the “buffer” function of ArcView to determine the water 
bodies that lie within the 10-year time of travel of all the tri sites that use poisons. A buffer is a zone of a 
specified distance around a feature and is useful for proximity analysis (e.g., finding something that is within 
a set distance of something else).

Make sure the Toxic Release Inventory data theme is active. Use the Query Builder to select only those 
compounds that are Poisons and save this theme as a shapefile, naming it “poisons.” Turn the Toxic Release 
Inventory data theme off and the poisons theme on. We will now create buffers around each of the sites to 
represent the distance that these poisons will travel in a year, and have 10 of them, one for each year.
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With the poisons theme active, use the Theme menu Create Buffers option (near the bottom of the drop-
down list). Click Next to buffer the features of the poisons theme. Select the option As Multiple Rings, and 
specify 10 rings with a distance of 1500 feet between rings (make sure feet is selected as the distance units). 
The reason we use 1,500 feet per year here is because this is the estimated rate of travel of groundwater in this 
area based on flow paths and directions and aquifer characteristics. Click Next. When asked where you want 
the buffers to be saved, select the third option “in a new theme.” Where you save it to isn’t important, so 
you can just click Next. The new theme “Buffer 1 of Poisons” will be added to the table of contents. Turn 
this theme on to draw it into the view. Click and drag this theme to the bottom of the list.

Print this map in the following manner:

Turn on only the County boundaries, Water bodies, Poisons, and Buffer 1 of Poisons themes. Use the 
View menu Layout option. Click OK to select the Landscape view. This will produce a printable map (you 
can change the title from “View 1” to “Poison hazards” by double-clicking on it). Use the File menu Print 
option to send it to the printer.

Important: Do NOT save any changes

What to turn in
Write up a page explaining what you’ve done and why. Start with a statement of the problem (the title of this 
exercise gives you a hint). Explain how you’ve solved the problem to someone who knows nothing about gis 
or the behavior of toxins in the environment.

In your write-up, explain how you grouped each compound (as an air, soil, or water hazard) and why.

Turn in the answers to the questions provided by your instructor—you can just list the answers 1, 2, 3, etc. 
Turn in the four maps you printed of the layouts for each of the hazards.
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  Add Theme—use this to add a theme to an open View.

  Open Theme Table—use this to open the data table of a theme.

  Query Builder—builds a query for a data set (table).

  Zoom to the Active Theme(s)—zoom into the extent of the active theme(s).

  Clear Selection—unselects all records in a table.

  Identify Tool—use this to identify a feature in an active theme.

  Pointer—select this to highlight, move, resize, etc. features in a theme.

  Zoom In—click this and use it to draw a box around an area you want to zoom in to.

  Zoom Out—click this and use it to draw a box around an area you want to zoom out of.

  Zoom to Full Extent—all themes in the Table of Contents are displayed in the view.

  Pan Tool—click on this and use it to move your map where you want.

  Sort Ascending—sort data in a table in ascending order.

  Sort Descending—sort data in a table in descending order.

  Promote—moves all selected rows to the top of the table.

  Switch Selection—toggles selected and unselected records in a table.

  Help—use this to get help on a particular ArcView topic.

Appendix A—Common ArcView 3.3 Buttons and Tools
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Appendix B: The Data CD
The data cd contains all the data layers and attribute tables needed to complete this exercise. Instructors 
can request a copy of the cd from the National Center for Case Study Teaching in Buffalo by emailing 
toxicrelease@sciencecases.org.

Below is a brief description of each type of information, specifically the attributes in each data file. Spatial 
data have been projected to UTM—1983: Zone 15N.

Toxic Release Inventory Data
The Toxics Release Inventory (tri) is a publicly available U.S. Environmental Protection Agency (epa) 
database that contains information on toxic chemical releases and other waste management activities 
reported annually by certain covered industry groups as well as federal facilities. This inventory was 
established under the Emergency Planning and Community Right-to-Know Act of 1986 (epcra) and 
expanded by the Pollution Prevention Act of 1990.

The data used in this exercise were obtained from the epa’s Toxics Release Inventory data set available on cd 
(this data was compiled for 1987-90) from their Office of Pollution Prevention and Toxics.

Shapefiles
This directory contains all of the shapefiles used in the project.

The following themes (layers) are visible when the project is opened in ArcView:
• County Boundaries: the seven counties that constuitute the Twin Cities (Minneapolis-St. Paul) 

metropolitan area in Minnesota, USA
• Water Bodies: lakes and water bodies within the seven-county metro area
• Railroads: main railway lines clipped to the county boundaries
• Toxic Release Inventory Sata: epa data set, 1990
• Soils in Hennepin County: Soil Survey Geographic (ssurgo) database for Hennepin County, 

Minnesota (mn053), published by the U.S. Department of Agriculture, Natural Resources 
Conservation Service, Fort Worth, Texas. The classification and map unit names were finalized at the 
final correlation in July 2001 at 1:15,840 scale.

The following definitions are provided for the attributes that can be found in the attribute table for these shapefiles:

Toxic Release Inventory data files
• toxic_release_inventory_data.shp

º shape, area, perimeter, tridata_id
º lat—latitude
º lon—longitude
º fac_name—factory name
º streetad—street address
º city—city name
º county—county name
º zip_code—zip code
º substance—the chemical substance used at this factory
º parentco—parent company of the factory
º chemgroup—chemical group to which this substance belongs
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Hennepin Soils data files
• hennepin_soils.shp

º shape, area, perimeter
º musym—map unit symbol
º muname—map unit name
º water_tabl—water table depth in feet
º flooding_f—flooding frequency from frequent to none
º drainage_c—soil drainage class from excessively drained to very poorly drained
º septic_tan—suitability for septic tanks
º sewage_lag—suitability for a sewage lagoon




